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1. The Workflow Document

1.1 Preliminary Remarks

Please consider the notes on installation prior to creating a workflow.

If you are working on the system as a "user" with limited access or as "domain
user" rather than via administrator or power user rights, you will have to start
the "Initial startup" shortcut prior to initial startup.

In case of problems, also read the "Readme.txt" file stored in the installation
directory; it contains notes and explanations, in the form of "questions and
answers", to the behavior of the "Documents Workflow COM-Add-Ins".

1.2 Open new document

You create a new Workflow document by clicking the shortcut to the document
template from your program menu (Fig. 1).

|, Accessories

b ¢ Devices and Printers
|. Documents

1 Workflow
W de

Default Programs

Help and Support

. en
| k3l Visio Document Template

L. Visio COM-ADD-In -

1 Back

| |555rrh programs and files

Fig. 1: Links on the program menu created by the installation
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1.3 Opening already existing workflows after initial installation

If a workflow has been installed in a different directory on initial installation, the
"WorkflowSet.vss" stencil for previously created workflows cannot be found
because it points to a different directory. Microsoft® Visio® then opens the
workflow without the stencil (shapes).

To connect the document in Visio® 2002 to the stencil, on the main menu, choose
the "Open stencil" entry via File and "Stencils”. In Visio® 2003/2007 you choose
the "File -> Shapes -> Open stencil" menu items. On Visio® 2010, you choose the
"File -> Open" menu items.

You then navigate to the installation directory, where you choose the
"WorkflowSet.vss" stencil. When clicking "Open" the document is connected
to the stencil. To ensure the connection is permanent, you should then save the
workflow.

1.4 Customize file locations

To ensure that stencil and document template can always be retrieved, you
should enter your locations in Visio (Fig. 2).

[ File Paths — S |
Drawings: | C:\Users\TS-Admin\Documents E
Iemplates:lC:hPrngram Files (x86)\Documents4\Workflow'en I[ l ’
Stencils: IC:hPrngram Files (x86)\Documents4\Workflow'\en| ” ] |

Fig. 2: Customize file locations for stencils and templates on Visio 2010
"File -> Advanced -> File locations -> Templates and Stencils path“
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1.5 UTF-8 support

Workflow version 2.0 or later, server version DOCUMENTS 4 (UTF-8) and Visio®
2003 support displaying UTF-8 characters. When submitting a DOCUMENTS 4
server without UTF-8 support, UTF-8 character representation is supported, but
the data will not be encoded in UTF-8 during export. Generally, no UTF-8 can be
used for technical names. UTF-8 fields are:

All shapes:

- Description
- Label
- When available in the dialog, the values for field values

Action

- Comment

- Task

- Recipient

- Escalation — To —From mail subject mail text
Control flow

- Confirmation message

- Visibility condition

- Guard condition

- Guard error message
- Comment

Receive Signal

- Escalation — To —From mail subject mail text
- Comment
- Condition

Send Signal

- Escalation — To —From mail subject mail text
- E-mail — Recipient — Sender — Subject — Content
- Comment
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1.6 Workflow shape

Each document created from this template has a workflow shape that has already
been inserted. This shape is used, among others, to control communication to the
DOCUMENTS 4 server; lists are managed, i.e. data is synchronized, and language
settings are made. Each workflow must have exactly one workflow shape because
information is stored in it which is accessed by other shapes.

You can delete the workflow shape at any time, and dock a new one on the
drawing sheet. Positioning the shape on the sheet is performed automatically (Fig.
3).

=]

a Workflowname
Intn a descriglion Import Lists from Documents

Doouments Properties

Export to Dooumenis

Show GUITHabel or technical name

LR S

Fig. 3: Workflow shape with context menu

You can edit the workflow shape by double-clicking or by starting the context
menu entry "Documents Settings (Properties)" entry (Fig. 4). The details dialog
that appears then allows you to specify the workflow in greater detail.

"M DOCUMENTS WORKFLOW Version 2.00 x|

Label |W0rkflowname

Hame |Workflow_1 Wersion 1

General l Desoiiption |

Language ¢~ German {* English
Shape-Text |GUI-Label (al) |

[ wirite shape autocomments

[~ Remave exclugive write lock

[~ Releaze

Import from Documents |

E=port to Documents |

Download |

Create new warkflow version |

Ok | Cancel |

Fig. 4: The Workflow details dialog

Each workflow requires, on the server side, an existing and released file type to
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which it refers and whose fields it uses. In the DOCUMENTS Manager you will
find the list of all file types under "Documents -> Filetypes" (Fig. 5).

- LI Administration
Aﬂ User Management
ﬂ All Accounts (8 Entries)
8 Alias (5 Entries)
b -8l Organisation Hierarchy (3 Entries)
fﬂ all Organizations (5 Entries)
: e | Country (3 Entries)
4.5 Documents
> -{=) Public Folders (4 Entries)
4 -7 Filetypes (6 Entries)
> 77 ftVacationApplication
> -7 fiSickCertificate
o7 ftOrder
> 07 fEmployee
57 ftRecord
4.7 flnvoice
Iﬁ company (String)
Iﬁ status (Enurmeration)

Fig. 5: File types in DOCUMENTS

If you type the text "ftinvoice" in the dialog box "File type" and start data
import from the server via the "Import lists" button, all fields marked by the file
type, as well as the appended tabs, will be determined, and processed for Visio®.

If you cannot enter a specific file type because, for instance, you do not know its
name, you will be prompted during list import on whether you want to perform
the update anyway. You need to click "Yes" to confirm this prompt.

You can select the file type then by re-opening the workflow shape from the
drop-down list. Only the released file types are entered in the list.
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Import lists

Because actions are assigned to specific users, groups, etc. in the workflows, this
data must be fetched from the server. In doing so, you need to log on to the
server via the corresponding login dialog (Fig. 6).

E’, Lagin ﬂ

Connection

Server ||Dca|h|:|$t

Part 111000

Idzer

Mame |$u:hrei|:uer

EEYEH]

Pazzword

Frincipal |peau:hit

Caonnect | Cancel

Fig. 6: Login dialog

The corresponding account must be set up on the server for the user prior to this.
Import is performed after successful login. The connection data (server, port,
name and principal) is saved in the workflow, so you do not need to re-enter it
upon renewed login.
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When you reopen the workflow shape, you will find that all file types the server is
aware of are entered in a drop-down list. When changing the selected file type
you should also perform list import again because the new fields and tabs coupled
to the file type are transferred as part of the import. As part of list import, the
names of the existing workflows, the names of the released archives, public
folders and Java scripts as well as document templates and tabs of the file type
are also determined (Fig. 7).

List import

{ open warkflow shape nter yes fﬁDIL L:ss:;e the: list of j

i
Import lists }

U S W
No Select file type from
selection list

L Imporﬁh\ }

® o
=

|

<
@
@

|

Fig. 7: Performing list import from DOCUMENTS

Workflow label and brief description

On reopening the workflow shape (Fig. 8), you can assign the workflow a
multilingual label that is also displayed in the shape text. See also the
"Multilingual labels" section. You can also specify a brief description about the
workflow's respective business process. All double quotes in the workflow
description text are replaced with single quotes on saving the workflow shape.

u]
Workflowname
Insert a description
| |
"m . DOCUMENTS WORKFLOW Version 2.00 x|

Label |Wnrkf|owname

Marne |W,:,rkf|,:,w_‘| Yersion 1

General  Description l

|Insert = description]

Fig. 8: The Workflow details dialog including the "Label”, "Name" and
"Description" fields
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Create a new workflow version

Use this function if you want to re-transfer a workflow without overwriting the
old workflow on the server. By pressing this button, new "IDs" for the workflow
and the shapes it contains are generated. Based on these IDs, the server
recognizes whether the workflow or its elements already reside in the database.

In addition, the version number is incremented by one level (increments of tenth/
one). You can also overwrite these by entering a different number. Please
consider that changing the version number alone is not enough to create a new
version because the "IDs" are not changed here.

Also be aware that the old or new version's document files (Visio®) are not saved
when the version is created. So, you should save the file via "File -> Save As"
and by giving it the corresponding name. The changes made as part of creating
the version cannot be undone.

Change workflow label

When changing the workflow label, you will be prompted, on saving the dialog, on
whether only a label change or a workflow copy should be created where the
version number is set to the value "1". In the latter case the IDs of the workflow
and its components are changed, as when creating a new workflow version.

Change workflow names

When changing the name of the workflow, i.e. the technical workflow name, all
IDs of the workflow and its components will be automatically changed.

Shape comments

By enabling the Write shape autocomments option (version 1.3.4 or higher) on the
workflow shape, the corresponding comments displaying, among others, a
summary of the set escalation levels with actions and the guard or the like with
control flows are created for all shapes of the active sheet on saving the dialog
(Fig. 9).

Besides the technical names, the interface labels for the individual portal
languages are listed. Display therefore is arranged as follows: If you have allocated
a general label, e.g. "Action", this will be used for all languages.
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If you allocate a label for a specific language, e.g. "en:Action;", the technical name
will be displayed in the other languages unless these also have a label.

@
(Mail} = : 'I ':
Positing infomation jfr" ooon
finish workflow

de: Ende

en: fimish weorkflow

Mame: Final5tate 4

Seal file: Actrve

Delete file after processing: Inactrve

Fig. 9: Automatically generated shape comments

The shape comment might not display all information because the Visio comment
field can only accept limited information and can only be influenced up to a point.
The comment that is displayed as a tool tip will appear when you roll over the
corresponding shape using the mouse, and briefly pause there. For reasons of
downward compatibility, the Default setting is disabled.

When this option is enabled, shape comments that already exist in the
workflow will be overwritten. So, you should not enable this option if you have
already placed your own comments on the workflow and its shapes!
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Remove exclusive write lock

If a user locks the DOCUMENTS file because they are responsible for the current
workflow step, they have exclusive write permissions to that file. In version 1.3.6
or later, this default behavior of the workflow can be changed by enabling the
"Remove exclusive write lock" for the entire workflow (Fig. 10). The DOCUMENTS
file can then be edited by another user if that user has the necessary permissions.

!; DOCUMENTS WORKFLOW Version 2.00

X|

Label |Wolkf|0wname

Narme fiyorkfla_T

General ] Drescription I

Language ¢ Geman {+ Englizh

Wersian ’71

Shape-Test |GUI-Label (en)

[ wiite shape autacomments

I v Remove exclusive wiite lock

I Releasze
File Type |
Irmpart from Documents
Export to Documents
Download
Create new workflow version
Ok, | Cancel |

Fig. 10: Remove exclusive write lock for the entire workflow

Changing write protection in the workflow shape impacts on the entire workflow

for all workflow elements belonging to the following types:

- Delay

- Action

- Receive Signal
- Send Signal
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For each of these elements you can define behavior deviating from the overall
workflow in the related details dialog (Fig. 11).

= Action x|

Label Iﬁ-\ction

Mame |Action_5

General | Escalationl Field Valuesl Fieldsl Tabbed Pages Eonne-:tic-nsl Descriptionl

 Processing
Tepe & Static (" Dynamic | Processing by alias/rale |
Recipient
AuthorizedSignatary
Crersesr
PersonnelManager
Reqgistry
ServiceManager
Exclusive write lock | ok flow j
ok flow
TEmoveE
~ Display don't remave
Task, I
Cormment I

[~ Openin edit mode

[~ Show Action list

[~ Show Copy list

[~ Mo mail notification

[~ MNoinbox filing

Expenditure I 1

ak. I Cancel I

Fig. 11: Exclusive write lock on an action
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Write protection of the affected element may follow the workflow setting

"workflow", or it can be explicitly "removed" or "not removed" for this element
regardless of which setting has been made for the workflow per se (Fig. 12).

= Raceive Signal % |[=send g x|
Lebel [Receivr Signd Label [5erdSignd
H Ham [Eonlina_3
¥ [Recervesinsl 2
L E|
Corneran | Epcalgtion | FiskdVahuss | Coractions | Desciipton | Connat [
e 1l || ] ]|
Loaked [
Lk [] et
Heme [Fcion_17
Hame [Doiay 4 Goraral | Excatation | FukiVakme | Fake| TabbedPagar | Connmction: | Dazcrotion |
F P ebong
E-mud|rddwm| ':O"Eml fops & Gie ™ Dmasc  [Proceasng by dhsadaie =]
Priaibic: Rttt |
7 Uss work calardar AuthanzodSigeesion
[T
" FessonncdbAansgor
T Feaicyatig
Servicolanagsr
Lt [Dragds) -
N Eschsiue wite ook [wtion m e 5] |

Fig. 12: Exclusive write lock for "Send Signal, Receive Signal, Action and Delay

Shape text

As of version 1.3.4, the shape text displayed on the Visio drawing in or next to the

shape can be influenced in its appearance in such a manner that the /abel
(ergonomic name) text or the name (technical name) can be displayed ( Fig. 13).

:!; DOCUMENTS WORKFLOW Version 2.00

x|

Label IWDrkquwname

Mame I'w'::nrkflnw_'l

General | D'ezcription I

Language (© German & Englizh

Yerzion |—1

Shape-Test |GUI-Label (en)]
[T “Wiite shape autocaomments
[~ Remaove exclusive write lock.

[~ Releaze

File Type I

=]

Fig. 13: Details dialog for workflow shape version 1.3.4

When selecting the technical name (filtered) setting, the technical name will only

be made visible when the shape has a label. The individual languages for which

interface labels can be allocated are determined on capturing the server lists.
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These must be specified via the DOCUMENTS Manager with the respective
principal (Fig. 14).

Spplication Sermacttng  Admnotuton Dommet Sl

L 1 e = T T

LI Adrmnistration [T PrTErpET— w|[= = L bd =)
+ - UserManagernent I |[Ex] |l i
- DaCumEnts Mot Ca Fhewl CipTan 2Pl Coe
(L] Feahilf DEMOFORTAL ety 15 W Gaereiad
T peachit (PeachiT DEMOPORTAL] - Portal
Satings | Advwitnaton | ebad Sewce | Propeies |
Pockal caree f Prircpsl FPoctal Languasgels|
Abbreviation peschi Fortel version | 7.00 Larguage | Deutzch Locsls gp [ Oriew
Cartier Laguame ¥ Erghich Locak: an [ Ordre

Fig. 14: Specifying the portal languages in the principal dialog

The Workflow dialog then lets you select the language to be displayed in the
shape text.

When selecting the GUI-label (...) representation (Fig. 15), the guard, visibility
condition or, as with escalation, the set time will be displayed in control flows and
operations with an empty name.

Language  Gemnan * Englizh

Shape-Test | GUI-Label (en] |

Technical Mame
Technical Mame [filtered)
GUI-Label [all)

GUI-Label [de

Fig. 15: Selecting the GUI-Label of the shape text in the Workflow dialog

The setting (Technical Name/GUI-Label) can also be switched via the workflow
shape's context menu (Fig. 16).

[rport Lists from Doouments
DoourmerylS Profer el
Eaprt i Docusments

Shaei GUL-abe of tedrachl s

L L &K

Fig. 16: Switching display mode via the workflow shape's context menu

When switching to "Show GUI-label", the switch is made to the respectively set
GUI-label of the Workflow dialog. If no GUI-label is selected there, the "GUI-Label
(all)" will be used.
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Export
For a description of performing export on the workflow shape, see chapter 4
below.

Release
By enabling the Release option, the workflow is automatically released in the
system after exporting it.

Download

A detailed description of downloading workflows (see button in Fig. 10) can be
found in chapter 4.5.
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P Working with Drawing Elements

The individual workflow elements are - typical in Visio® - transferred from the
stencil to the drawing sheet using Drag & Drop. You can create a workflow per
drawing sheet, where the Visio® document file may contain multiple drawing
sheets. To enlarge or reduce the drawing sheet, position the cursor at the edge of
the sheet, keeping the ctr1 key depressed.

2.1 Start node

Each correctly working workflow has exactly one start node. In addition, the start
node may only have exactly one outgoing connection; incoming connections at
the start node are not allowed. The red color of the shapes refers to the
corresponding connection error.

2.2 Control flow

Next, dock a control flow, and then connect it with the start node. When this
snaps in at the start node, the warning color on the node should disappear, and
the following picture, as shown in Fig. 17 emerges.

Fig. 17: Insert control flow
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If you want to accurately draw straight connection lines, you press the shift key
(see Fig. 18).

Fig. 18: Dragging at the end point, keeping the Shift key depressed

You can also make connections at right angles by moving the control flow shape
on the blue handle (Fig. 19).

Fig. 19: Simple dragging at the handle for rectangular redirections

If you press the shift key at a handle with a selected control flow, you can
create rectangular bulges (Fig. 20).

Fig. 20: Dragging at the handle, keeping the Shift key depressed
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Dragging, keeping the Cctrl key depressed, ensures right-angle connection lines.
Connect the action shapes directly with the control flow and, keeping the Ctrl key

depressed, drag it until a right triangle emerges (Fig. 21).

Fig. 21: Dragging at the handle (Control flow center), keeping the Ctrl key
depressed, for right-angle connection lines

You can also adjust line routing, keeping the Ctrl key depressed (Fig. 22 and Fig.

23).
D

Fig. 22: Dragging at the top right handle, keeping the Ctrl key depressed, until the
dotted line has the desired shape.

Ausrichten an Geometrie |

Fig. 23: Dragging at the bottom right handle, keeping the Ctrl key depressed. The
dotted line indicates the new line routing.

All changes that you create by dragging can be undone by dragging into the
opposite direction analogous using the same keys.
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2.3 Action

Now dock an action shape on the drawing sheet, and let it snap in at the control
flow (Fig. 24).

Fig. 24: Storing and connecting start node, control flow and action

Action shapes require at least one incoming and at least one outgoing connection.
Select the existing control flow by clicking it. Then select the action, keeping the
ctrl key depressed. This multiple selection allows you to insert multiple
elements via Copy & Paste into the drawing sheet (Fig. 25). When copying created
shapes, specifications that have already been made are usually imported. This
excludes the "name" of the shape and its "/D", an internally used number for
unique identification of a shape.

Aktion T
! 0 |
| F-y |
Aktion
N /|
i, 0 |

Fig. 25: Storing two shapes on the drawing sheet
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If you want to connect a multiple selection to another drawing element, as in this
example, the control flow to the action, you will have to select the newly created
control flow, i.e. deselect the multiple selection and snap in the control flow in the
connection point of the existing action (Fig. 26). The appearance of a multiple
selection depends on the respective Visio version used.

| Kleben an ‘u’erl::linu:lungspunlctl
Aklion

Fig. 26: Connecting a control flow to an action

2.4 End node

Now store a closing control flow emanating from the action on the drawing sheet,
and connect it with a new end node (Fig. 27).

Aktion

Aktion

Fig. 27: Storing and connecting control flow and end nodes
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Each workflow must have at least one end node from which no other connection
may emanate. The workflow may contain multiple end nodes.

When creating a workflow, generally make sure that all routes of the workflow
end in well-defined states, i.e. control flows end at end nodes or elements from
which in turn emanate connections to other elements. A connection ending at a
solitary element is a dead-end for the workflow.

2.5 Moving shape texts

For better transparency, the shape text can be moved to a different position.
After selecting the format icon "Rotate text block" on the default toolbar, a
moving marker will appear when placing the mouse on the text. The text can then
be moved to the desired position, keeping the left mouse button depressed (Fig.
28).

Start | Einfagen  Entwurf | Daten  Uberprafen  Ansicht  Entwicklertools
= Ausschneid i . = - Zeigertool [~
j & Ausschneiden Arial copt. <A A === iz A lg Zeigertool []
n 53 Kopieren & Verbinder X
Einfagen - A~ EI==E| iE iE m
- JFormatUbertragen F & U ae Aa L Bl — B B A Text @
Zwischenablage Schriftart Fl Absatz Tools
“Tenxt 1
.\\
&
= o]
S
@ Tept 1 @
= A =
= R =
Y

Fig. 28: "Default" toolbar -> Rotate text block, move moving marker on the shape
text to the desired position, keeping the left mouse button depressed

Start Einfugen Entwurf Daten Uberprifen Ansicht Entwicklertools
= Ausschneide . v = — Zeigertool
j = Calibri T 12pt. v A A === = \
- 53 Kopieren — Verbinder X
Einflgen - E|I=|==|EE
= # Format dbertragen F A& U abeha” | & SI=EI==1F 3 A Test &
Zwischenablage Schriftart Fl Absatz u Tools

A Text 1

Fig. 29: Next, select "default pointer" (pointer tool).

By clicking the default pointer (arrow icon), see Fig. 29 top right, you can exit text
edit mode.
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2.6 Grouping shapes

Be aware that grouping Visio shapes to a (1) new overall shape is not supported
by the DocUMENTS Workflow add-in! This means that when connecting a grouped
shape, for example, to a control flow, the group shape will not be recognized as a
workflow shape and therefore not exported.
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3. Workflow Element Specification

The following input fields exist for each workflow element:

- Label
- Name
- Description

The entered label is also displayed in the shape text. In the case of some shapes,
this text can also be edited on the drawing sheet. The text for the "Action", Send
Signal", "Receive Signal" and "Subworkflow" shapes cannot be edited because the
text in these shapes is built and written by the program running in the
background. However, these shapes also allow moving the text.

The label is also used to allocate the button labels in DOCUMENTS 4. For more
information on this, see chapter 3.2.

As of version 1.2, the label can now be entered in multiple languages. Thus,
DOCUMENTS 4 allows defining the button labels or entries in the function list for
each active language.

Multilingual labels

This is performed according to the "online language abbreviation" rule, followed
by "value" and "semicolon", e.g. "de:Aktion-1;en:Action-1;".

The DOCUMENTS Manager lets you enable the "Support multiple languages"
option on the "Locale/Format" tab (Fig. 30).

Ja! Documents - Settings &u
el ng

GIu:-baISetting&' Diocuments [I:-asiu:]l Archive [I:-asic:]l List e:-tpc-rtl Docurents [display]  Localedfarmat |Lngbnok| Lic|d |+

Format settings

Date format [WIMM;"DD v] Decimal point E]

Suppart multiple languages

Locale de Date format ’DD.MM.YT"N v] Decimal point

Locale 1

Locale 2

Locale en Date format IMMHDDN‘N‘K v] Decimal point E

Fig. 30: "Documents -> Settings -> ->Locale/format”
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In order for this setting to become effective, you need to define and enable the
languages in the DOCUMENTS Manager as "online languages" of the principal
(see Fig. 31).

Puortal Language(z]
Language 1 Degtzch Locale ge | Online

Language 2 Englizch Locale e | Online

Fig. 31: Principal -> Settings -> Portal languages

The name of a workflow element should be unique in the workflow, i.e. allocated
once only. Moreover, it should not contain a dot and be Java-compliant because
it is used to access additionally implemented extensions (UserExits) in Javacode. If
the name of a workflow changes, the internally used /D of the shapes within this
workflow will also change.

As of the DOCUMENTS 4 version and Workflow version 2.0, the name of a
workflow element may be up to 255 characters long. The limit in previous
versions was 25 characters. While saving a shape adherence to this restriction is
checked and, if necessary, the corresponding warning is displayed. This check is
performed for all shapes.

The description is used to enter a text in which you can save any information.
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3.1 Action
Actions are defined in the following dialog, shown in Fig. 32.
= Action x|

Label I.-’-'xctiu:url

Mame |.-'-‘u:tiu::n_‘| 3

General |Escalatiun| Field '\-"aluesl Fieldsl Tabbed Pages Eonnectionsl Descriptiunl

— Processing
Type & Static ¢ Dynamic IProcessing by aliaz/role LI
R ecipient
AuthorizedSignatory
Crerseer
Fersanneltdanager
Registry
Serviceblanager
Exclusive write lock | ok flow LI
~ Dizplay
Task I
Comment I
[~ Openin edit mode
[~ Show Action list
[~ Show Copy list
[~ Mo mail natification
[ MNoinbaox filing
E=penditure I 1

(3 I Cancel I

Fig. 32: Action details dialog
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Processing
Processing an action can be assigned to various users (Fig. 33). Here the entered
recipient of the action is the "PersonnelManager (Secretary)" alias (see Fig. 34).
The edit could also be performed via a named user, an alias or a group of
employees.

If the DOCUMENTS file is allocated only for "information", then the user will
receive the file only for viewing; the workflow will continue after deploying the
file. The different processing options are available in the drop-down list.

|F'ru:u:essing by aliaz/role j

zzing by alias/role
Proceszing by a uzer
Processing by a group member
Procezsing by all group members
Informing an aliasdrole
|nforming a uszer
Informing all group members

Fig. 33: Processing type of an action

If the recipient's allocation is static, then the recipient will be - whether employee,
group, etc. - already present in the system and has been fetched by the server via
the workflow operation "Import lists" and entered in the drop-down list as a
possible recipient. The recipient of the action will then be selected from that list.
If the edit were performed via a user, then the recipient list would, in case of
static assighment, be populated analogous with all users the system is aware of
("Schreiber, Willi", "Stern, Andrea", etc.) and be presented for selection.

Processing

Type & Static ¢ Dynamic |F'ru:u:essing by alias/role ﬂ

Recipient | Personnelid anager

AuthorizedSignatory
Chearseer

Fegistey
Servicebanager

E sclugive write lock | wiarkFlaw ﬂ

Fig. 34: Processing is statically assigned to the "PersonnelManager" alias
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In the case of dynamic type of processing, the recipient (the user, group, etc.) is
determined first via evaluating a field value, and then assigned to the action. The
recipient list displays all fields of the file type. As shown in Fig. 35, the editor of
this action is a user because "Processing by a user" has been selected.

The field from which the user is read corresponds to the current field value of the
"Contact person" field. The value for the contact person of the previous file editor
must be entered. The DOCUMENTS file is then forwarded to the determined user.
If you chose "Processing by a group" as the processing type, the field value of
"HRCustomer" would be interpreted as the name of a group. The same applies to
processing by an alias/role. Field names may not contain a comma or semicolon.

Processing

Type [~ Static & Dynamic  |Processing by a user j

Recipient |HR customer

hrErnail
hrEmployveeMo
hrFirsthame
hrLastMame

hrLogin
hrFemarks j

Fig. 35: Processing is performed by a user, dynamically assigned from the
"HRCustomer" field

If processing is performed by a group member, execution may be performed
optionally asynchronous or synchronous (Fig. 36). If processing is to be performed
by a group member, the DOCUMENTS file must be stored in each member's Inbox.
Only when this has been performed for all group members will a positive or
negative response to the initiating user be sent, if necessary. For groups with a
large number of members this process may cause significant delay. Whereas for
asynchronous execution, the user can continue with his work immediately without
having to wait for a completely expired assignment. Execution is always
asynchronous with "Informing all group members" (Fig. 37).

Pracessing

Type (& Static ¢ Dynamic |F"ru:u:essing by a group rember j

v Aszynchronous execution W Diszolve group

Fig. 36: "Asynchronous" and "synchronous" execution

Processing

Type & Static ¢ Dynamic Informing all group members
[v Asynchronous execution |
Fig. 37: Asynchronous informing of a group

When sending the DOCUMENTS file for information to all members of a group,
you can also define that file assignment should be performed asynchronous, i.e. in
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the background of the application, which facilitates immediate continuation of
work, or that the file should be sent synchronous, i.e. it is sent to all group
members ad hoc and complete for the entire group before continuing with the
DOCUMENTS file is possible.

Dissolve group
When the "Dissolve group" action is disabled, only the editing group and, if
necessary, the name of the group member, will appear in the monitor list (Fig.
38).

User Status Received:

Documents, Import Sent 0aM 12011 0817

service [Schreiber, Will] | Forwarded | 0871152011 08:17

Fig. 38: Display group name and group member with disabled dissolution

Each individual member within the group also appears in the monitor list when
this option is enabled (Fig. 39).

User Status Received:

Documents, Import | Sent 08/M11/2011 08:51
schreiber, Willi Forwarded | 08/11/2011 0&:51
schmidt, Miriam Informed 08/11/2011 0&:51
Frizch, Eva Informed 08/11/2011 0&:51

Fig. 39: Display all group members with Dissolve group enabled

The selected recipient of an action is displayed in the shape text, enclosed in
parentheses, after clicking "OK" to confirm the details dialog
"(PersonnelManager)" (Fig. 40).

4

(Service)
Aktion

N

Fig. 40: Shape text with actions

(PersonnelManager)
Aktion

N

DOCUMENTS Workflow User Guide 30



Task — Comment

Save Cancel not OK || OK

processing details  Documents (1) Status

Fig. 41: Task - Web

The text entered in the "Task" field is displayed by DOCUMENTS 4 on displaying
files in the monitor list and in the DOCUMENTS file's task line (Fig. 41). As of
version 1.2, the task text can be entered in multiple languages, e.g. "de:Konto
priifen;en:Check account;". For more information, please refer to the
following section: "Multilingual labels".

The comment, which can also be entered in multiple languages, will be entered
after forwarding the DOCUMENTS file if you have not specified a comment for the
forwarding control flow itself. If processing the action has been "for information"
only, and therefore automatically, the comment and the task will not be displayed
(Fig. 42).

User Status R d Resp File OK Task Comment
Buch, Bernhard Locked 08/11/2011 08:58 Check reliability if order is above 500 Euro

Decision Pazsed 08/11/2011 08:58 | 08/11/2011 08:58 Order larger than
Service [Schreiber, Will] | Forwarded | 08/11/2011 08:55 | 08/11/2011 08:58  Yes Check for plausibility Order accepted

Fig. 42: Monitor list — task and comment - Web

Open in edit mode

When this action is enabled, the DOCUMENTS file will be directly switched to edit
mode, i.e. it can be edited immediately on opening it. When this action is
disabled, the file editor must first press the "Edit" button to be able to make field
entries.

Action list - Show copy list

b || Edit | | Actions... =l]copyto... =]

Fig. 43: Action list — copy list - Web

When these options are enabled, the drop-down lists for "actions" or "copy" will
be displayed with a saved DOCUMENTS file (Fig. 43).
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No mail notification

As of workflow version 1.3.4, the Display group now allows additionally enabling
the No mail notification option, where delivery of an e-mail message via the file
Inbox can be prevented if such has been set up for the user (user settings
"Personal Folders").

Diigplay
Tazk |

Comment |

[ Openin edit mode
[ Show Action list
[ Show Copy list
[ Mo mail notification

[ Moinbox filing
Fig. 44: Turning mail notification on/off

Expenditure

The "Expenditure" field lets you add a numerical value to the action which reflects
the costs or expenditure of performing the action. The default value of this field is
lllll.

This version does not yet support server-side evaluation of the expenditure value.

Escalation

Should editing the action not be performed within a certain period, the workflow
may respond to this with gradual "escalation". This avoids leaving important
documents unprocessed during the process, or that the workflow stalls unnoticed
(Fig. 45).

Type |Delegate bo user ﬂ

E-ail Mezzage
Tao Delegate to user
Delegate to aliaz

From « Delegate to group

Back to initiator

Fig. 45: Escalation type

The escalation type determines the manner in which the escalation is to be
performed. If the action is "delegated", the action will be withdrawn from the
originally assigned editor and the processing transferred to another editor, alias
or group.
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The DOCUMENTS file can be returned to the original file creator using "Back to
initiator". When sending the "e-mail message" the original editor will continue to
be responsible; however, an e-mail message for information about the delay in
editing will be sent to a selected editor. The mail subject and the mail text also
allow using Auto texts (Fig. 46).

[v Level1 active

Timne |1 |Hn:|ur[s] j [ Use work calendar

Type |Delegate bor ser

=l
To % Static " Dynamic |Dppen,Bernhard ﬂ
=l

From ¥ (" |

Subject

i il
message

Fig. 46: Escalation — File editing is assigned to "Oppen, Bernhard"

DOCUMENTS Workflow User Guide 33



Here the action is forwarded to employee Bernhard Oppen unless it has been

edited within an hour. You can select Minutes, Hours, Days, Weeks and Absolute

as the time unit. Next, you can define that the specified time span refers to the

annual calendar or to the working calendar (Fig. 47). Because the pending

escalation jobs on the server can be checked at five-minute intervals, e-mail

messages with an escalation time of under five minutes can only be sent delayed.

il Documents - Settings

8 & |

DOCUMEMTS gettings

Mew users with automatic DOCUMENTS access

Global Setting:  Documents [bazic) l.t‘-‘«rchive [basic]] List ewpart | Documents [displa_l,l]] anale.ﬂ'format] Logbnok] Lic| 1 | *

#

? |t |

Searg

® - Calendar - — —
Wark hours l Holida_l,ls]

Sunday from [[:00:00 = to 00:00:00 =

Monday from 0S:00:00 % bo 16:00:00 =
Tueszday from 05:00:00 % bo 16:00:00 =
Wednesday from 03:00:00 % bo 1E:00:00 =
Thurzday from 0Z:00:00 % bo 1E:00:00 =

Friday from (08:00:00 o to 1E:00:00 -

Saturday from 00:00:00 5 bo 00:00:00 =

Caticel

Hit list # allowed functions

= —

Maximum DOCUMENTS hits 250
POF creation [Print]
[7] Forward
Ewport
Archive
Delete
Calendar
Use calendar I Open calendar... I
Apply [ Cancel l ’ Delete file pool ]

e

Fig. 47: Settings for the calendar
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If you choose an absolute time, the format of the timestamp must match the

settings in the DOCUMENTS Manager under "Main menu -> Documents ->
Settings -> Documents settings -> Format settings -> Date

format". If DD.MM.YYYY has been selected there, then the required format for
the timestamp reads: DD.MM.YYYY ss:mm (with two spaces between date and
time).

i bl
13 pocumens - et -

GIDbaISettings] Documents [basic]] Archive [basic]] List exportl Documents [display]  Localedformat l Logbonk] Lic| 4 | *

Farmat settings
Date format IWHMMHDD v] Decimal point E]

Support multiple languages

Locale de Date format [DD.MM.Y’YW -] Decimal point

Locale 1

Locals 2

Locale an Date format [MMIDDMW v] Decimal point E

Fig. 48: DOCUMENTS settings -> ->Locale/format

Depending on whether a static or a dynamic recipient determination is made, the
recipients available for selection in the drop-down list are displayed. When
delegating the DOCUMENTS file to a user, group or alias, the user, group or alias
list will be displayed with static determination. During dynamic determination the
fields that the file type contains from which the user, group or alias is then to be
read as a field value. When selecting the "Back to initiator" form as escalation
type, the DOCUMENTS file will be forwarded to the file creator.
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Field values

Fields of a file type can be set to defined values by an editor at the beginning and
end of the action, i.e. prior to opening and after closing (Fig. 49). Thus, the value
of the "Priority" field is set to "normal” here. You can create the values via the
"New" button from the field values list or via the "New" button from the edit
dialog.

To edit the values, double-clicking an entry is enough. While editing, all known
fields are displayed with their technical name in the list on the left. To generate an
empty value ("), you leave the value field on the right empty accordingly.

Field names may not contain commas or semicolons.

Generall Escalation Field Values | Fieldsl Tabbed F'agesl I:l:nnnectil:unsl Descriptil:unl

Incarming event Edit
MHame M ame " alue
hrLasth ame hrLaztt ame S chreiber

hiFirztM ame -
hrlnternalComnment

hrl_asth ame

hiLogin

hrReazon

bR emainingD ays0 R acation
hrStartD ate

hrStatuz

hrSubstitute -
hrType 57

Ok, I Mew I Cancel |

Mew | Deletel

Fig. 49: Field values for the "Priority" field

The fields for which the values have been allocated are displayed in the field
values list (Fig. 50):

Generall Ezcalation FieldValues | Fieldsl T abbed F'agesl I:n:nnnec:tin:nnsl Descriptianl

|heoming event

Mame W alue

hrLastM ame Schreiber

Fig. 50: Field values list for Inbox
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Auto texts as field values
Auto texts can also be used as field values; the current date is used for the auto

text $currentDate%.

Field references as field values

They can also refer to the value of other fields when allocating values. Thus, for
instance, $Priority% is replaced with the current value of the "Priority" field.
This option is also available when allocating an e-mail subject, e-mail text and the
comment fields.

PortalScripts as field values

When you enter "runscript" as the field name and the name of the script to be
run as the field value, the specified Java script will be executed on the server side
(Fig. 51).

General] Escalation Field Yalues lFieIds] Tabbed F'ages] Eu:unneu:tiu:uns] Descriptiun]

|ncoming event

Mame Walue
rurEcript zefalue

Fig. 51: Setting a field receipt value through Java script

Fields

As of version 1.2, this tab lets you regulate access to fields for the user. If you do
not make any entries, all fields with read and write access for the user in the Web
front-end will be displayed with their technical name. When allocating the
permission for a field, only that field will be displayed with the corresponding
permission, i.e. you need to select other fields, even if these are to be displayed,
and assign them with the corresponding authorization. Fields from the list of
"Available fields" will then not be displayed.

When pressing the ">" button, you can transmit a selected entry from the list of
"Available fields" to the list of "Selected fields". Double-clicking an entry also
allows you to initiate moving. In doing so, the permission is set depending on the
selected access option. All list entries are transmitted by clicking the ">>" button
(Fig. 52). For selected fields in the list of "Selected fields" you can then define the
access type via the option buttons "Mandatory field" (RWM), "Read/Write" (RW)
and "Read-only" (R). Multiple selection of entries is allowed here. Checking the
required fields, where you need to enter a value, will be performed within the
DOCUMENTS file on switching tabs if the file is in edit mode. The "Hide all fields"
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option lets you generally suppress display of all fields on the Web. Field names
may not contain a comma, semicolon or the reserved label "runscript".

= Action il

Label Ide:Vertretung;EniSUbSHtUtEJ

Mame IAu:tiun_S

Generall Esu:alatiu:unl Field Values Fields |Ta|:u|:ueu:| F'agesl Connections | Description

[~ Hide all fields Access

[~ Mandatary
&l fields [ Readfwrte

¥ Feadonly
Zref hiE mploveeMo.hrSupenor Selected figlds
hr&pproveal
hr&pprovealD ate Field Mame | Acocess
hi&pprovedBy hrEmployeeto (R
hrCalendardbjectd 5 hiFirsth ame =
hrC.omment hiLastName (/)
hrLruration hiladin =)
hrEndD ate ¥ | h Stgt =
hrlnternalConmment rataius (R)
hrR eason
hrR emainingD ay=0 A acation
hrStartD ate
hrSubstitube

hrT ype

< | +]

Fig. 52: Selecting the fields and specifying the access rights for "Selected fields"

contact person

Meldung von Webseite ﬂ

5. The following errors occurred while saving the fields:
/ l % Mo value spedfied for mandatory field, (contact person)

=1

Fig. 53: Error message for mandatory fields, e.g. "Contact persons" field
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Tab

Order i ng details  Documents (0) Status

Fig. 54: Tab view in DOCUMENTS 4
The tabs displayed in DOCUMENTS 4 can be set on the following tabbed page.

Here, too, the following applies: If no tab is selected, all available tabs of the file
type will be displayed in DOCUMENTS 4. The technical name of the tab will be
displayed here. Once you select a tab, only that tab is displayed. If you want to
display other tabs as well, you need to select them. The tabs will be determined
when you execute the "Import lists" operation on the workflow shape. You will
find the tabs included with the file type in the editorial client. The "Fields" and
"Status" tabs are default tabs which cannot be removed.

Access can also be defined as read access or write/read access for the tabs (Fig.
55). Tab selection and permission assignment are made as with the fields. The
"Hide all tabs" option lets you generally suppress displaying all tabs — with the
exception of the default tabs - on the Web.

Tab names may not contain a comma or semicolon.

General] Escalation] FieldVaIues] Fields Tabbed Pages ll:onnections] Drescription

[ Hide all tabs Tab access

" Read/wiite
Available tabs {* Read-only
| Selected tabs

Tab Mame | Access

hisbsenceaT ab [R]
hiRecords R

- EL

<

ol |+

Fig. 55: Selecting the tabs and defining tab access
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Connections

Outgoing Connections

Marme Label

ContralFlo I.-'-.I_EE: Ot

ControlFlow_22 Qut3

ControlFlow_24 Qut
Up | Croen |

|ncoming Connections

M ame Label
I1

ControlFlow_20 Ind

Fig. 56: Incoming and outgoing connections with arrangement option

On the "Connections" tab (Fig. 56) you can see a separate list of incoming and
outgoing control flows on the shape. You can directly open the corresponding
control flow by double-clicking a list entry. In doing so, the action dialog is saved
and closed. In reverse, the relationship fields "From" shape and "To" shape that
the control flow dialog contains allow opening the details dialog of the
corresponding connection shapes. These navigation options enable you to
navigate through the workflow even without clicking the shapes. The connection
page is not displayed for the start, end and subworkflow dialog.
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The outgoing connections can be moved via the "Up" or "Down" button. This

defines the order (From top to bottom) in which the buttons that are equivalent
to the control flows are displayed in DOCUMENTS 4.

Bearbeiten Cut 1 Cut 2 QOut 3
In1 In2

Auzgehende Yerbindungen
Aktion Mame

Bezeichnung
ControlFlow_5
ControlFlow_E

Out 2
ControlFlow_¥ Out 3
Out 1 Out 2 Out 3

Fig. 57: Connection order and arrangement of buttons in Web front-end
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3.2 Control flow — Operation - Escalation transition

5 Control Flow ﬂ

Label | Outd
Mame |I:|:|ntr|:|IFI|:uw_22

General l.-’-‘-.cu:ess] Field "Jalues] Description

Guard
[ Script | J

Condition

Error meszage

Drigplay
Control |Eutt|:|n j
M avigation |Keep file iy wigw j
Comment
[w File Ok
[ Leave in Inbox
[ “withdraw from other Inboxes
[~ Copyto"Sent ltems' folder
[vw Fonward directly
Modes

From }fl'-.cticun_'l 9. J

T|:||

Ok I Cancel |

Fig. 58: Control flow details dialog

The control flow (Fig. 58) describes transition from one workflow element to
another. This transition can be "guarded", i.e. made to depend on a condition
occurring. In an operation a transition to the same element occurs.

In doing so, however, new incoming files are not triggered. The operation is
therefore used to assign fields new values via field values. If a transition is to be
performed as part of an escalation, you can set a time after expiration of which
the transition is automatically performed. An escalation transition may only
emanate from an action, subworkflow, send signal or receive signal shape. For
escalation transition and control flow, the rule applies that the transitions of
different shapes must be connected to each other.
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Multiplicity

A maximum of one escalation transition may be appended to a shape. With
exceptions (start and end nodes), multiple control flows and operations can be
docked.

Guard

The transition from one item to the next - forwarding - can be "guarded", i.e. the
transition will only be performed by the system when a specific condition is met.
This expression can be specified in the "Condition" field.

If, for instance, two action shapes Al and A2 are connected to a guarded control
flow, the DOCUMENTS file will be sent back to the editor of Al if the transition
condition is not met. Only when the condition is met will the DOCUMENTS file be
forwarded to the responsible editor of A2. Evaluation results of the condition are
also included in the monitor list.

The guard is evaluated after actions where the DOCUMENTS file is actually edited,
i.e. file editing is not limited to a simple "information" task. An evaluation is also
performed when the control flow is part of a decision shape.

Error message

If the condition is not met, you can specify the error message to be displayed
here. An error message can only be entered for control flows that come from
actions.

Script

The conditional check can also be performed via a server-side Java script (Fig. 59).
By enabling this option, a Java script will be released from the list of known
scripts. This list will be imported when you perform the "Import lists" operation
on the workflow shape.

The condition is satisfied when the script has a return value of "1 (returni;)".
The error message entered, where present, is output with a return value of "0".

Guard

[+ Script |set"v"alue ﬂ

Condition

Error message |fielu:| contact perzan is mandatary

Fig. 59: Script-based conditional check
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Access and visibility

General | l Field Yalues | Description
Wizible
[~ Script | J
Condition
Confirmation
M ezzage

[ Check paszword

Fig. 60: Controlling access and visibility with control flows and operations

As of Workflow version 1.3.4, the Access tab (Fig. 60) allows you to influence
whether a transition, as a button or as an entry in the functional drop-down list,
should/may be displayed or not.

For this, you can explicitly allocate a condition that controls visibility. However,
visibility can also be determined from the iteration of a script that checks for
permissions or other restrictions, for example.

If visibility is available and the condition is met, a message may be displayed
which you need to confirm so that the process is finally executed, e.g. "When you
execute this process, then DOCUMENTS files will be permanently deleted.
Perform the delete operation? (OK/Cancel)". When the Password Check function
is enabled, you additionally need to enter the password of the logged-in user to
ensure the process is completed, and forwarded.
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Escalation time

::; Escalation transition ﬂ
Label “

Marme |I:|:|ntr|:|IFI|:|w_25

General l Field \:"alues] Descriptinn]
E zcalation bime
[ Uze wark calendar

Time |

Uit | D als] j

Digplay
[ “ithdraw from other Inboses

Maodes

Fram |

T|:||

| Ok I Cancel |

Fig. 61: Timings for an escalation transition

You can specify a time in an escalation transition (Fig. 61) after whose expiration
the transition is automatically performed.

Next, you can determine that this time should refer to the annual calendar or the
working calendar. Length of time and time unit will be displayed as shape text
unless you have specified a name for the shape. See also section Use working
calendar. As of version 2.0, you can also specify an absolute and therefore fixed
time.

Button labels in the Web front-end

In DOCUMENTS 4, the of the technical name of the control flow is used as
primary button label. It should always be allocated within the meaning of clear
user experience.

If a technical name is missing, the system will take the technical name of the
following workflow element ("Action 2"). If that element does not have its own
technical name either, the system will perform labeling depending on the
following workflow element. This corresponds to the technical name of the
element (see Fig. 62 "Action_10").
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Whereas if a control flow has a label, that button label will be used ("OK", "To
Action 1"), depending on whether the workflow element that follows has been
assigned a label or not.

Start
i
E 3
without cantrol flow name ‘ l ‘ control flow name .to action 1" | ‘ action name ,action 1
e e -
{Schreiber, Willi & to action 1 o  (Schreiber, Willi)
Action 0 '\X Action 1
i 5 #
{Schreiber, Willi) ‘
Action 2
e
(Schreiber, Willi) \
‘ action name action 2* ‘ Action i
‘ without cantrol flow name ‘ ‘ without action name ‘

(Schreiber, Willi)
Action

{

without action name, technical name
is .action_10"

Save Cancel to action 1 Action 2 Action_10 oK

Fig. 62: Control flow name and button labels in workflow step "Action_10"

Button arrangement, i.e. the order in which they are loaded via DOCUMENTS 4
can also be influenced: See Connections in chapter 0.
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Multilingual labels

The label can also be created in multiple languages in DOCUMENTS 4. This is

performed according to the "online language abbreviation" rule, followed

by

"value" and "semicolon", e.g. "de:Aktion-1;en:Action-1". The DOCUMENTS
Manager lets you enable the "Support multiple languages" option on the

"Locale/Format" tab (Fig. 63).

GlobaISettings] Diocurments [basic]] Archive [basic]] List export] Documents [display]  Localefarmat lLogbook] Lic|* | *

Format sethings
Date format | i /0D - Decimal point E

Support multiple languages

Locale de Date format | oo pdM oy - Decimal point E
Locale an Date format | it /00 Y - Decimal point E

Fig. 63: DOCUMENTS settings -> Locale/format

Laocale 1

Locale 2

i ]
9 poumen:- sering N

In order for this setting to become effective, you need to define and enable the

languages in the DOCUMENTS Manager as "online languages" of the principal

(Fig. 64).

Puartal Language(z]
Language 1 Degtzch Locale de [¥] Online

Language € Englizch Locale en Online
Fig. 64: Principal -> Settings -> Portal languages

Form of representation in DOCUMENTS 4
Besides the function buttons, the labels of the control flows can also appear

as

entries in a functional drop-down list in the Web front-end. The selected function

is triggered by clicking the adjoining icon. In the following workflow from Fig.

65

the outgoing control flows from 1-5 were arranged on "Actionl", where the

representation was selected as a "drop-down list" as the interactive element for

control flows "2" and "4". Control flows "1", "3" and "5" retained their defa
settings ("Function button®).
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The function list always appears last, after the function buttons.

# { (Schreiber, Will) £ (Schreiber, Willi) "
3 Action Action »

(Schreiber, Willi)
4 Action 2
3
Y Y
(Schreiber, Villi) (Schreiber, Willi) -
; . (Schreiber, Willi)
Action Action i Action
] —_—
P
s

Save || Cancel ||1]|3 EIFunction...'Iﬁj

‘Function

Order proce Documents (0) Status

Fig. 65: Rendering options: Function button and drop-down list

Navigation

Navigation allows you to specify which view should be displayed after editing the
DOCUMENTS file, i.e. after it has been forwarded. Thus, for instance, the editor
can be returned to their "Inbox folder", "For overview", to the "next DOCUMENTS
file to be edited" or back to the same DOCUMENTS file ("Keep file"). In an
escalation transition, the existing DOCUMENTS file is always kept with the
transition.

Comment — File OK

User Status Received: Response: File OK Task Comment

Buch, Bernhard Locked 081172011 11:13 Check reliability if order is above 500 Euro

Decision Passed 0812011 11:13 | 08A12011 11:13 Order larger than 500 Eure
Service [Schreiber, Will] | Forwarded 08&/11/2011 11:12  0&/11/2011 11:13 | Yes Check for plausibility Order accepted
Schreiber, Willi Sent 08112011 11:42 | 08112011 1112

Fig. 66: Monitor list
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The "File OK" and "Comment" fields let you specify a brief state description of the
DOCUMENTS file which is entered in a monitor list in an overview presenting the
route and history of DOCUMENTS file through the workflow (Fig. 66). While with
"File OK" you can generally switch the file state to "OK" or "Not OK", you can also
enter auto texts in the comment, e.g.:

"Audits are performed by %userFullname% on the %currentDate%".

If a value is allocated to the "comment", this cannot be overwritten even if the
"Forward immediately" option is disabled. Also, in case of manual forwarding, the
value for "File OK" will not be evaluated because this must be entered on the
routed page itself. In an escalation transition, the file state is always set to "OK".

Leave in Inbox
You can set here that a DOCUMENTS file is retained in the user's Inbox even after
it has been edited.

Copy to "Sent" folder
Here you can define whether a file copy should be stored in the user's "Sent
Items" folder.

Forward immediately

When this option is enabled, the DOCUMENTS file will be immediately forwarded
to the next user without displaying the routed page. In doing so, the "File OK" and
"Comment" fields are set as specified above.
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When this option is inactive, a routed page will appear (Fig. 67) which allows the
option - when clicking the value "No" for "File OK" - for a "enquiry", "Forward to"
or for "Forward to default recipient" (Workflow). In an escalation transition the
transition is always performed as an immediate forwarding.

Forward file

File OK? & Yes (T Mo

Comment | Order not correct

(= Forward to default recipient
[emailtddresz]

" Forward to
= Confer with

Task
Forward == Cancel

Fig. 67: Routed page

If an "enquiry" is performed, the DOCUMENTS file will be initially sent to another
employee in order to be sent back to the sender via a new routed page after it has
been edited (Fig. 68). When "forwarding" the DOCUMENTS file, the DOCUMENTS
file that has already been edited will be sent to the next workflow element via
another employee.
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While forwarding to the "default recipient" you switch to the next element, as
specified in the workflow (Action -> Action). Enquiries and forwarders are logged
in the monitor list. The formation of an enquiry string where employees of the
prompt start a new enquiry themselves is not supported.

]
ingquiry call
| back
& {Employee)
2 Action via
ol
forwarding

(Gross, Stefan) o
Action

Fig. 68: "File OK" — enquiry and forwarders

The disabled option "Forward immediately" will only be evaluated after actions
where the DOCUMENTS file is actually edited by a group, alias or user. If the
preceding workflow item is edited by the system (e.g. signal, decision, etc.),
forwarding will be automatic, i.e. immediate.

Withdraw from other Inboxes

When this option is enabled, the DOCUMENTS file will be removed from other
users' Inboxes. This is useful, for instance, when it is enough that only a group
member must or should edit a DOCUMENTS file.

In doing so, the DOCUMENTS file is initially stored in the Inbox of all group
members. Once the DOCUMENTS file is edited by an employee, it will be
automatically removed from the Inbox of the other group members.

As of Workflow version 1.3.4, this option can also be turned on with modeled
escalation, the escalation transition. As the workflow continues at the escalation
time, the DOCUMENTS file is removed from the Inboxes of the other users to
prevent direct editing after escalation.

Field values

The "Field values" tab lets you assign, as with the action (see above), specific field
values to fields in transition to the next workflow element.
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Connected nodes

Modes

From Ifl'«cticun_ﬂ - faction _I
To Ifl‘«cticun_2 - Achion _I

Fig. 69: Relationship to the nodes that the control flow connects

This group displays which nodes are connected with each other on the drawing
sheet (Fig. 69). The target node "From/to" is always the shape at the arrowhead.

If the relationship exists, i.e. the control flow is connected to a shape, you can
immediately open the details dialog of the corresponding shape by pressing the
button on the right. This closes the control flow dialog, and the changes made are
saved and the details dialog of the relationship shape opens.

Analogous, the details dialogs of the relationship shapes contain a tab named
"Connections" that lists the incoming and outgoing control flows on the shape.
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3.3 Send Signal

B send Signal |_

Send Signal

SendSignal_14

ML Erport |_
workflow 7]

Fig. 70: Send Signal details dialog
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3.3.1 Type
The workflow element "Send signal" (Fig. 70) lets you send a "signal" to which
other applications may respond (external sending) or give the workflow system
the signal for internal conversion. The corresponding setting is made in the "Type"
field (Fig. 71):

Tipe |:J-:1-'IL Expor

e el
pohiiea BArchive
= ol kac: | el in Toddes
Charge lelype
Al Bema e .. Revascipd

Fig. 71: Send signal type

XML export

#ML Export | Escalationl Field \-"aluesl Fieldsl Tabbed Pages Connectionsl Descriptionl

Outbox |

Job |

[~ Export without docurnents
[~ Export status
[~ Expart maritar

Fig. 72: XML export including export of status and monitor information

This signal type initiates an XML export, i.e. creating an XML file with the fixed
field names and field values in the specified Outbox, i.e. an existing directory on
the server. In doing so, the documents assigned to the DOCUMENTS file will also
be stored in a subdirectory in the Outbox when the Export without documents
option has not been enabled.

In this case, a reference to this directory is additionally written from the XML file.

Additionally, status and monitor information can also be exported, where an
HTML file that contains this information is respectively created. A reference is
then written to these HTML pages within the XML file (Fig. 73).

DOCUMENTS Workflow User Guide 54



If XML export is to be performed without documents, these information pages will
not be generated.

Monitor
User Status Received: Response: File OK
Schreiber, Wili | Sent 08/11/2011 13:55 | 08/11/2011 13:55

Schreiber, Wili = Forwarded = 08/11/2011 13:55 | 08/11/2011 13:55 Yes
PXML: c:\mp] Performed 08/11/2011 13:55 | 08/11/2011 13:55
Workflow end | Finished 08/11/2011 13:55 = 08/11/2011 13:55

Statusl

Action Comment Time User

Finished sending 08/11/2011 13:55 = Schreiber, Wili
DOCUMENTS file forwarded 08/11/2011 13:55  Schreiber, Will
Started sending 08/11/2011 13:55 | Schreiber, Wil
File edited 08/11/2011 13:55 = Schreiber, Will
Distribution list created 08/11/2011 13:55 = Schreiber, Will
DOCUMENTS file created 08/11/2011 13:55 = Schreiber, Wili

Fig. 73: Exported monitor list and exported status information

The Job field lets you specify the name of a batch file that will be started after
export from the server. The path to the created XML file is passed to this data file
as a parameter (Fig. 74). This allows you to initiate ongoing processing of data via
a third-party program.

<?xml version="1.0" encoding="UTF-8"7>
- «files>
- «file id="peachit_fi20110000000120" type="ftOrder">
<title> Bestellung 01.07.2011 11:57 </title>
=field name="status">received </ficld >

=field name="orderId"/=
<field name="orderDate"/ >
<field name="deliveryDate"/>
<field name="HRcustomer"/=

<field name="company"/>
<field name="contact’/>
<field name="emailAddress"/ >
<field name="telephone"/>
=field name="to_OrderItem"/>
<field name="comment”/=
<field name="processingcomment”/ >
=field name="deliveryAddress"/
<field name="invoiceAddress"/ >
<field name="HRpayment"/>
=field name="netPrice"/>
<field name="vat"/>
<field name="total"/>
<field name="paymentreceipt">0</field=
<field name="payment">creditcard </field>
=field name="paymentDate"/>
=document register="documents"peachit_fi20110000000120\documents\Status.htm</document=
<document register="documents"=peachit_fi20110000000120\documents\Monitor.htm=/document=
<ffile>
</files>

Fig. 74: Example of an XML file from export
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E-mail

b ail IEscaIatiu:unI Field Valuesl Fieldsl T abbed F'agesl Connections Descriptionl

Recipient * Staic  © Dynamic I ﬂ
Sender (¥ Staic  © Dynamic I ﬂ
Subject

b il
message

Fig. 75: Signal type —E-mail
This signal type (Fig. 75) is used to send an e-mail message.

The recipient or sender can be statically determined, and will then be a user of
the system, e.g. "Schreiber, Willi", or a fixed preset e-mail address, e.g.
service@peachit.de. During dynamic determination, the address is determined

from the value of the field that has been selected from the drop-down list. Auto
texts can also be used in the "Subject" and "Mail body" fields. When the Don’t
attach documents option is enabled, the file documents will not be added to the
e-mail message.

Archiving
If during archiving "static" mapping is enabled, you can initiate export to the
selected archive from the list of existing and released archives.

The archive names available for selection are fetched from the server when
pressing the "Import lists" button in the workflow shape. When selecting the
"<Archive>" archive, the DOCUMENTS file will be deposited in the file type's
target archive. When the Export without documents option is enabled, file
documents will not be transferred to the archive.

If status and monitor information is to be also archived, this must be specified
directly on the file type via the DOCUMENTS Manager (Fig. 76).

| File type: fiRecord (peachit fi20070000003506)

General ] Advanced zettings ] whorkflow  Archiving l Actions ] Scripting ] Properties ]
Archiving
Destination server | wain server -
Archive status Archive manitar Archive document meta-data
Actions
Create archive filex Guick creation of archive files ] Reactivate

Fig. 76: Archive monitor, as well as destination server and target archive selection
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Group

This signal initiates internal grouping of the DOCUMENTS file into the public folder
selected from the list. The available folders are determined on the workflow
shape while executing the "Import lists" function. This function is primarily used to
represent incoming DOCUMENTS files more transparently for the user and to pre-
sort them.

Change file type

This signal type is used to instruct the workflow to use the file type selected from
the list rather than the previously used file type. The switch impacts on the entire
DOCUMENTS file. The file structure is customized to the new file type here. The
workflow can then respond to fields not present in the previous file type. The list
of available file types will be determined when you execute the "Import lists"
function on the workflow shape. This will then be available with "static" mapping.

If the DOCUMENTS file to be switched to should be determined from the value of
a file field, i.e. "dynamically" assigned, you will have to select the corresponding
field from which to read the value (Fig. 77). The list of field names will be
determined when you execute the "Import lists" function on the workflow shape.

If a field name corresponds to a file type, the switch will be made directly to the
file type; in this case, the field name will not be interpreted as "dynamic".

Change filetype | Escalatiu:unl Field "»-"aluesl Fieldsl Tabbed F'agesl Eu:unneu:tiu:unsl Dezcription

Type + Static ¢ Dunamic

Filetype

ftEmployes

ftirwvoice

ftQrder

ftRecord
ftSickCertificate

ftw acationdpplication

Fig. 77: Change filetype dynamically

Fields from the original file type which are not present in the new file type will be
lost, including their field values, during the further edit operation of the file.

So, an intersection of the jointly used fields should be available when changing file
type and, moreover, the replaced file type should be used to determine basic
data.
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Changing file types (see Fig. 78) will be necessary when subworkflows created on
a different file type should be initiated and when field values should be modified
by the system or by user input in this subworkflow. Switching will not be
necessary when working with different workflows of a file type.

Start
e
2 :} incoming fax
i
(Service)
check fax
invoice purchase order
(Change filetype) (Change filetype)
change to invoice change to po

order
processi

invoice
processi

Fig. 78: Change file type, and subworkflow
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Java script

Here (Fig. 79) you can specify the name of a server-side Java script from the list
which is executed via the send signal. This list will be populated with the familiar
server-side scripts when you execute the "Import lists" function on the workflow
shape.

Javasenpt |Escalati0n Field Valuesl Fieldsl Tabbed Pages | Connections | Description

Script hame

cmsWebContent_Release a
DocFileHelper

hrAppaintmentClass

huSickCertificate_onS ave

hrf acationdpplication_createdppointment_Signalk «it
hr acationdpplication_onS ave

invoiceR epart

libtadordhd L

libtafardi L. Fooker

libtwéardhd L. Header

lib\ordtL.Image

libvwfordh L. Paragraph

libtwfardhdL. T able:

libeshd L

mzglbl LI

Fig. 79: Executing server-side Java scripts

Comment

Here you can define a text with or without using auto texts for the monitor
overview of the DOCUMENTS file which is automatically entered as an edit note
after sending the signal.
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3.4 Receive Signal

In reverse, you can use the Receive Signal (Fig. 80) to wait for a condition to occur.

Ed

Label ||

bEL3 IHeceiVESignal_El

Cormmoty I Esu:alatiu:unl Field \-’aluesl Eunnectiunsl Diescription

Exclusive write lock Iwu:urkfll:lw j
[T Script I j
Condition
Comment
k. Cancel

Fig. 80: Receive Signal details dialog

File editing will be locked against all users until that condition is met, i.e. the
workflow pauses at this point. As a rule, the send signal is used when the value of
a file field is modified by a third-party program. The occurrence of the condition
can also be checked via a server-side Java script; to do this, you need to enable
the "Script" option and select the validation script from the list. This selection list
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will be populated when you execute the "Import lists" function on the workflow
shape. The condition will be met if the script has a return value of "1 (return 1;)".

You can also enter a message for the monitor list using auto texts in the Comment
field. Using the escalation mechanism, you can respond to the non-occurrence of
the condition. The occurrence of the incoming signal condition is included in the
monitor list. Validation is performed by the server at 5-minute intervals.

3.5 Subworkflow

%

Label | sub-workfiow

Mame ISuI:uwu:urkqu:uw_ﬂ
Azsignment & Static T Dpnamic
Subeaark flow I j

Dezcription

k. I Cancel |

Fig. 81: Subworkflow details dialog

Using the subworkflow you will be capable of starting other workflows like a kind
of subprogram. While "statically" assigning the subworkflow (default value), the
workflow selected from the drop-down list is started as a subworkflow.

The drop-down list will be populated with the names of the workflows existing on
the server when you start the "Import lists" function on the workflow shape.
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If the assignment on which subworkflow to execute is to be performed
"dynamically", the drop-down list will be filled with the names of the file fields.
The subworkflow entered as a value in the selected field will then be executed.
The listed names are formed from the workflow name, a hyphen, and the version
number. You can also, if known, directly enter the name of the subworkflow (incl.
version number).

Start
H
= :’} incoming fax
i
(Service)
check fax
invoice purchase order
(Change filetypa) {Change filetype)
change to invoice change to po
invoice order
processi processi

End

Fig. 82: Change file type on using subworkflows

If the subworkflow uses a file type other than the current workflow, you should
change file types prior to starting the subworkflow if field value are to be changed
in the subworkflow by the system or by user input.

In Fig. 82 an incoming fax document is checked on whether it is a purchase order
or an invoice. In the case of an invoice, a change is made to the "Invoice" file type,
followed by starting the subworkflow "Purchase invoice-1". The file type change
always impacts on the entire DOCUMENTS file (global). If the file type of the
subworkflow and the current workflow are identical, you will not need to change
file type.
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If a subworkflow should be designed recursively, it must be exported first to make
the server aware of it as a workflow. Following this, the server lists must be re-
imported. After that, you can select it from the "subworkflows" drop-down list,
and then export it. "DOCUMENTS workflow" is equipped with a "recursion brake";
it recognizes workflows which automatically start in an endless loop.

Please be aware that the "Seal file" and "Delete file" options are not evaluated in
the end states of the called workflows because this could impair usability of
created workflow modules and might cause blockage of the calling workflow.

The following restriction has been incorporated for the subworkflow shapes:

Only one (1) control flow may emanate from a subworkflow shape.

The corresponding warning is displayed on appending another control flow.

3.6 Delay shape

# " # \x >< >< ><
w

i

«  Verzogerung = = Delay 4 %
L 4 ® b a2 s

x\\ ControlFlow_23
Arbeitskalender
verwenden: Aktiviert
Verzdgerung: 1 Minute(n)
Kommentar:

Fig. 83: Delay shape including ergonomic and technical name as well as automatic
shape comment

The delay shape (workflow version 1.3.4 or higher) allows performing time-driven
transitions (Fig. 83 and Fig. 84). Used in parallel/or workflow processes, this may
function as a timeout signal for a process string (see chapter 3.8).
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%

Label I De|a_|r+

Name |Delay_27

General |Field Valuesl Ennneclionsl

— Properties

[¥ Use work calendar

Time I
Unit | Minutes) =l

Exclusive vrite lock IWkaﬂDW j

Cormrmemt

 Dezcnphion

Ok | Canicel |

Fig. 84: Details dialog of a delay shape

Multiplicity
Only exactly one control flow may emanate from a delay shape. Appending an
escalation is not allowed.

Use working calendar

When using a working calendar with the principal (Fig. 85), the time units will be
calculated in relation to the calendar, i.e. if there should be a delay of three
working hours, which can sometimes be interrupted by a work free weekend, the
use of the working calendar must be enabled (Documents-> Settings->Calendar).
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&) Documents - Settings I, ? 2 I

Global Settings  Documents [bagic) |Alchive [basic]l Ligt export | Documents [displa_l,J]I analef’fnlmatl Logbookl Lic|sa]k

DOCUMEMNTS zettings
Mew users with automatic DOCUMEMNTS access

r‘ _ Calendar — — - — m‘

whork, hours | Holida_l,lsl
Sunday from [{i:00:00 = to 00:00:00 =
Monday from 08:00:00 = to 16:00:00 =
Tuesday from 02:00:00 = to 16:00:00 = 3
Seart Wednesday from 080000 2 to 16:00:00 : )
Thursday from 08:00:00 = to 1E:00:00 =
Friday from (08:00:00 o bo 16:00:00 :
Saturday from (00:00:00 o bo (000000 :
Appl

Hit list # allowed functions
Maximum DOCUMENTS hits 250

POF creation [Print)
[] Forward

Export

Archive

Delete

Calendar

g calendar

=) = g e =i L =) p

Apply ’ Cancel ]’ Delete file pool

.

Fig. 85: Global settings->Calendar
Execute by time
This lets you define after how many time units the forwarder should occur.

The times set will be displayed in the shape text if no separate label has been
allocated to the shape.

Please be aware that server-side checking of the times is performed in a
separate server job which, depending on the configuration, is performed at a
specific interval, e.g. at a five-minute interval. As of version 2.0, you can also
specify an absolute and therefore fixed time here.

DOCUMENTS Workflow User Guide 65




Comment
The comment entered here is displayed in status and monitor view on forwarding
the DOCUMENTS file.

Connections
The incoming and outgoing connections to other shapes which exist to this delay
shape or emanate from it are displayed here.

The following restriction must be adhered to for delay shapes:

A delay shape may have multiple incoming control flows, but only exactly one
(1) outgoing control flow.

3.7 Simultaneous sequence and synchronization

The workflow shapes "Simultaneous sequence" and "Synchronization" (Fig. 86)
enable you to split the workflow into different side-strings.

{ Action

Fig. 86: Modeling simultaneous sequence and synchronization
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The workflow is locked on the synchronization point until all substrings have
queued up at the endpoint. A processing string may therefore not terminate in
between; it must iterate through to the synchronization point (Fig. 87).

‘ changing area is not allowed ‘

] — Action
| =
! | [
I xfx—L"\
o Action } Action >)— —

| e | [l e Bt I
= _{x/";fgf\} ‘ cmsscon;-lugc‘:jeogsaranot ‘ I
I |
| 2l |
| Y
I ‘ changing area is not allowed ‘ A = 4
_____ Action } ‘ end nodes are not allowed ‘

L I

Fig. 88: Start and end for substrings "String 1" and "String 2"
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Each substring may only have exactly one starting point with which parallel
processing respectively begins. All workflow items stemming from this substring
must merge into exactly one and the same ending point on the synchronization
point. If, as in Fig. 88 on the left, multiple ending points (End 1 and End 2) emerge
for a substring, these must, as shown in Fig. 88 on the right, be reduced through a
decision/merge to a single point (End 1).

Consider the following rules for modeling:

1. For each simultaneous sequence there must be exactly one related
synchronization point.

Processing strings must iterate from branch to synchronization point
Connections between different processing strings are not allowed

A parallel and synchronization section may not be left

vk wN

A processing string has, including its branches, exactly one starting and
one ending point.

6. Field value changes always apply to the entire DOCUMENTS file. They are
not limited to substrings.

Parallel Parallel

Synchronisation

Synchronisation

Parallel

Fig. 89: Synchronization and parallelization

Simultaneous modeling of synchronization and parallelization, e.g.
synchronization from three to two parallel strings (see Fig. 89 on the left), is not
allowed. This must be preceded by reduction to a simple processing string (see
Fig. 89 on the right).

If the option for the editor of a DOCUMENTS file to become active in multiple
strings is available, e.g. because the editor is a member of different groups,
navigation in control flow leading to parallel branch, should be switched to
"overviews".
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In the "tasks" section of the overview table or directly in the tasks folder itself, the
editor can then recognize in which string and in which workflow step editing tasks
accrue. This requires that a "Task" has been allocated in the respective action
which can then be displayed.

[ x|
Labed [[
Hame [Fork_37
I~
FiekdVshie | Conmesctions | Bescrpion |
Irecming eveni
Hama [k |

SR N it
(¥
Latsl ||

Hame [ &0
r

| Fakd Wit | Comrmections | Descrpton |

Irsconrang wvenk
Hame I\l'll_n |
| |

Fig. 90: Details dialogs — simultaneous sequence and synchronization

As with the action, the details dialogs to these shapes allow entering field values.
For more detailed information, see the relevant section Field values in chapter 0.

3.8 OR branches and synchronizations

Workflow version 1.3 provides two new shapes for designing parallel processes
within a workflow.

In conventional parallel processes, each string must iterate completely by itself so
that the workflow does not pause on the synchronization point waiting for all
strings to be processed before it continues, as in the figure, with the action for the
Warehouse group. When modeling using the OR parallel and OR synchronization
shapes, it is enough that one (1) substring has been completely processed by
itself, arriving at the OR synchronization point.
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The workflow then does not wait for the other string to complete; instead, it
immediately continues the process after the OR synchronization shape.

>< %
4 Delay f(
X Xﬁi DWESJ}X y

T
(Warehouse) }
Action »

Fig. 91: OR parallel and OR synchronization shapes

In Fig. 91 it is therefore enough that the Service department, for example, has
executed its action so that the Warehouse can begin its action. If the Service
department has not processed its action within a day, the Delay shape will
become active and the workflow will continue with the action for the warehouse.
The Service group can then no longer edit the DOCUMENTS file.

For OR parallel and OR synchronization shapes, the same modeling restrictions
and regulations apply as for the conventional simultaneous sequence and
synchronization shapes. See also chapter 3.7.

In addition, the following rules apply that must be adhered to for correct
processing of the workflow steps:

A parallel process introduced with an OR parallel shape must also terminate
with an OR synchronization shape.

A parallel process introduced with a parallel branch shape must also terminate
with a synchronization shape.

Toggle the parallelization type

E
Label |0f
M ame IFnrhl:lr_EE
i i
Field Value i ipti
alﬂnrmhumlﬂﬂsmp'“”l ﬁg,m Eak=S Or - Join
Incoming event *

Fig. 92: Toggle between OR and conventional functionality by enabling/disabling
the "Or" option
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By disabling the Or option (Fig. 92), an OR parallel shape can be turned into a
simple Fork shape. Analogous, the Fork shape can be turned into an OR parallel
shape by enabling the relevant option. This option of direct conversion is not
available for workflows version 1.2 and earlier. If you want to make a change to
the parallelization type using these shapes, you will need to completely replace

these shapes and specify them accordingly.

You can also glean the parallelization type from the window title of the respective

details dialog (Fig. 93).

Label || Label |04

Name |Fork_40 Name |ForkOr_d4
ﬁ@  or ﬁ: or-Fok [v Or

Label || Label |04

Name [Join_d8 Name IJoinOr_SZ
ik T om @O

4

Fig. 93: Parallelization type and its representation in the dialog title
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39 Merge - Decision

In many cases, the path of a workflow can be automatically determined through
decision and merge shapes (Fig. 95) and the evaluation of branch conditions. The
conditions are specified in the adjoining control flows. This also allows using auto

texts in the conditions.

Label I

Mame IDec:isin:nnM erge_AH

Field Yalues | Connections | Description |

|heoming event

M ame Yalle

(=10 | Deletel

Outgoing event

I ame Walle

=10 | Deletel

Ok I Cancel |

Fig. 94: Details dialog — Merge — Decision
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decision

consolidation

Fig. 95: Merge decision

Conditions emanating, as shown below, from an action shape and connecting to a

decision shape are always interpreted as a condition for the action shape, not as a

condition for the decision shape.

"4

Aktion

OK

l

Fig. 96: Control flow condition
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When creating decision shapes, make sure that one condition always applies. An
outgoing control flow should contain an "else" branch as a condition expression to
ensure that a decision branch can always be iterated through. If a decision cannot
be made, the workflow may be idle at the decision point.

v

(Service)
receiving control
i :]C i

OK

g

i L amaunt = 500
decision x

confirm
consolidation W e
% s B B,
(XML Export) = . .
posting data
s e e s L

Fig. 97: Decision and merge chain in a workflow

Since the respective state of the shape, whether this is a decision or merge shape,
is dependent on the number of incoming and outgoing control flows, the shape's
interior is dimmed in case of a merge. In the case of a decision, the shape
background is set to white. The respective state can also be gleaned from the
heading of the details dialog.

\\\ Label ||
N \‘k Name IDBcisinnMerge_B
O )
™,
R ™ )\\ Y
=, Sagrete
‘( £ \\ 4
« a
$
\
5
Label || Y

Mame IDecisionMerge_B

Fig. 98: Appearance for decision/merge

DOCUMENTS Workflow User Guide 74



Particularly when designing a decision or merge chain in a workflow, you should
consider clear and functional assignment of the shape, whether decision or
merge, because the workflow in the chain is more often than not automatically
evaluated and controlled (Fig. 98). Shapes that might be interpreted as a hybrid
state on account of their design (see Fig. 99, on the left) can be split into two
single shapes including carefully-defined states, as shown in Fig. 99, on the right.

., /’
\\\\ .
4K Merge

e Merge or decision?
! l Reduction to 1

% Decision

Fig. 99: Splitting an item into two functionally separate items
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Operations or control flows emanating from the shape and ending on the same
shape, i.e. referring to themselves, are not allowed on the shape. The decision
made and the evaluation of the decision expression are also displayed in the
monitor list.

As within the action, the details dialog of the shape allows defining field values.

3.10 Start node

Each workflow must have exactly one start node (Fig. 100). Although transmission
can be made on the server, the starting point of the workflow will only be
retrieved if the start node itself is present.

%

Label ||

Hame JiniialState_14
[~ Archive fil
Field Values | Deseription |

Outgaing event

MHame Yalue

Hew Delete |

Ok I Cancel |

Fig. 100: Start node details dialog
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Moreover, the start node may only have exactly one outgoing connection which -
unlike the normal control flow - does not allow specifying the "Guard", "Leave in
Inbox", "Withdraw from other Inboxes" and "Forward immediately" fields,
because actually sending the DOCUMENTS file and, with it, the active phase of a
workflow only starts with the first action.

Incoming connections are not allowed with start nodes. Only a connection that
does not represent an escalation transition may emanate from it. If you want to
return to the initial state during modeling, you will have to create a connection to
an initial state (Fig. 101).

Aktion b SE—

Aktion —

Fig. 101: Start node and returning to an initial state

You can also define field values for the exit with the start node.
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3.11 End node

Each workflow must have at least one end node (Fig. 102). No connections may

emanate from an end note; however, multiple connections may end there.

If no separate label is allocated for the end node as well as for the control flow

leading to it, the button label "Finish" will be used in DOCUMENTS 4.

Label ||

Mame IFinaIState_'IE
[~ Sealfile

[~ Delete file after processing

[ Auchive file

Field ¥ alues | Ennnectiunsl Dezcnption

|nizoming event

x|

I ame W alue
Few | Delete |
Ok, | Cancel |

Fig. 102: End node details dialog

Seal file

When you enable this option, the DOCUMENTS file will be sealed at workflow's
end, i.e. locked against any other form of editing within and also outside of the

workflow.
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This setting will be ignored if the workflow has been called as a subworkflow
because the end state of the called workflow is interpreted only as a step out
signal in the calling workflow. Sealing the DOCUMENTS file must then be activated
in the calling workflow.

Delete file

When this option is enabled, the DOCUMENTS file will be deleted with the
workflow end. This option is used in particular when the DOCUMENTS file has
been moved to an archive with a send signal.

File deletion will not be executed if the workflow has been embedded as a
subworkflow, because the end state of the called workflow is only interpreted as
a return signal in the calling workflow. If you want to delete the DOCUMENTS file,
you must set this in the calling workflow.

You can also define field values for the receipt of the end node. Moreover, the
“connections" tab lists the incoming connections.

Archive file

As of version 2.0. the option to specify archiving a DOCUMENTS file directly on the
details dialog is available. This requires that the corresponding archive has been
assigned to the file type in the DOCUMENTS Manager (Fig. 103).

_
) File type: ftRecord (peachit_fi20070000003506) *

General] Advanced settings] Wlorkflow  Archiving ].-’-\ctiuns] Scripting] F'mpelties]

Archiving
Destination server Ipeachit5t0r31 vI

Archive status Archive manitor Archive document meta-data

Fig. 103: Assigning an archive for a file type

Alternatively, this can be remedied in earlier workflow versions in that a send
signal including archiving is modeled before the end shape.
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4. Export and File Type Mapping

4.1 Export

After specification of the workflow items you can perform the export on the
DOCUMENTS server by pressing the corresponding button "Export to Documents"
in the workflow dialog. You can also start this process from the workflow shape
context menu. Here you also login on the server; finally, a transfer message
appears.

4.2 Error messages during export

Errors on exporting a workflow are also logged and displayed in a list after
transfer. The respective list entry allows opening the related details dialog for
correction. The error messages can be written TAB-separated in a data file via
"Save as".

Fehlermeldungen

iziaShape-ld | Technizcher Mame | Mame | Wadert | Fehlemeldung
Kontrollfluzz.B1 - She...  ControlFlow_5 AutoComment Kormmentar - Komm...  Die Zeichenkette AutoComn

Kontrollfluss

Bezeichnung I

Hame IEontrolFlow_E

Allgernein IZugriffl Feldbelegungl Bezchreibung
—wiachter

I~ Script | ;l

Eedingung

Fehlermeldung I

&4
Schliefen | Speichem unter - Anzeige
Interaktionselement IFunktionsknopf j
Navigation I M appe beibehalten j
RGN E I o e ntar — Fommentar — Kommentar — Kommentar —

L4 hdznns Ol

Fig. 104: List containing error messages during export

The presence of errors does not mean (!) that the workflow has not been created.
Ordinarily, the workflow is not created, where erroneous values are not or
incorrectly set.
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The error messages will be displayed in workflows as of this version 1.3.8 if the
workflow has been created via the installed Visio document template. In earlier
created workflows, the display can be activated by selecting the workflow shape
using the mouse and opening the ShapeSheet via "Main menu -> Window ->
Display ShapeSheet" (Visio 2002/2003). In the workflow ShapeSheet, you then
need to set the field next to "ServerMessages" on the right to the value "error"
and save the Visio drawing (Fig. 105).

:
L O PO FROCETOUULTVOTY FOTIN FROPETOUTLTPOT POTEL i or<TORTL DRTUY FOVEE FEUPL VU DRORTTOVEE FOVITOI ot TOVOL FPLTOENN FRUEt FOVVLTYTIOOO FOOOTT

]
. Workflow_1

Fiigen Sle hier eine Beschreibung ein...

™

Benutzer. WFMArchives

Enutzer. WEMArchives_Custom
Benutzer . WFMFaolders | "Rechnungsarchiv;SEARCH; ™
Fenutzer. WFMFalders_Custom | ™
Benutzer. WEMFiletypes | "cmsWWebContent;EingangsrechnungPos; hr ApplicationForLeave; hrEmployee; hrReco
nutzer. WFMFiletypes_Custom

Benutzer, WFMFields | ™

e

Benutzer. WFMFields_Custom
Benutzer. WFMRegisters
utzer, WFMRegisters_Custom
Benutzer Filetype | "hrEmployee”

Benutzer. TechMName | “Workflow_1"

™

Benutzer, Version | "1,30"

| Benutzer ServerMessages I "error”

Benutzer WFMWorkflows | “de:Auftragsbearbeitung'jen:order processing-1;Rechnungseingang-1;WrApplicati

Fig. 105: Option for activating error display
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4.3 Workflow file type

In the last step the workflow must be linked to the file type to which it refers. Log
on to the server via the DOCUMENTS Manager and select the file type (Fig. 106)
you want to work with, e.g. "ftInvoice".

. .F@ Administration

1& User Management

. ----- i All Accounts (8 Entries)
£} Alias (5 Entries)

. -3k Organisation Hierarchy (3 Entries)
----- &k all Organisations (5 Entries)

4.7 Documents
- (21 Public Folders (4 Entries)
4 (77 Filetypes (6 Entries)
b - ftVacationApplication
> .7 ftSickCertificate
5. ftOrder
> -0 ftEmployee
> 47 ftRecord
A_"l ftinvoice
ﬁ company (String]
ﬁ status (Enumeration)

Fig. 106: Selecting the file type

Open the associated details dialog (Fig. 107) by double-clicking or by pressing the
spacebar. Next, on the "File type" tab of the dialog, you click the table icon with
the workflow relationship.

General] Advanced zettings Wk fow l.-’-‘-.ru:hiving] .-’-'-.u:tiu:uns] Scripting] F'r-:uperties]

Workflow
Drefault digtributiaon list

Wwhorkflow

Fig. 107: The "File Type" tab including the "Workflow" relationship

In the selection dialog, which displays all available workflows, choose the
workflow to be connected to the "Default" file type.

This workflow is the default workflow for the file type. For example, it will be
displayed on creating a new DOCUMENTS file when defining the file type for the
new DOCUMENTS file.

When you load a changed drawing of the default workflow to the server via
Visio®, this relationship will be automatically reset throughout all file types to
which this workflow was assigned as the default workflow. Whereas if a workflow
is already connected to the file type and if you export a completely new workflow,
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the relationship will not be set, i.e. the relationship to the default workflow still
exists.

The latter also applies when you have created a new "workflow version" via the
workflow shape or changed the "name" of the workflow. Both cause the internally
used /Ds to change; the relationship is not set.

r . hl
5. Selection e —— @
Search | <all text colummns: - l l - 'l | v T @ 3]
Type MHare Wersion TechnicalMame Description
WEMWorkflow  decUrlaubsantragenVacation &pp... 2 WEApplicationF orLeawve Bearbeitung +
WEMWoarkflow  de:Krankmeldung:en:Sick certificate; 2 WFSickCertificate Behandlung «
WEMWoarkflow  enlnvoice Processing:de:Rechnu.. 1 InvoiceProcessing
WEMWorkflow  desAufragsbearbeitungen:Orderp.,. 2 OrderProcessing Abbildung de
< | 1 [
’ Select ] [ Cancel ]

Fig. 108: Workflows selection dialog

After pressing the select button, the image seen in Fig. 109 should emerge:

Eeneral] Advanced zettings  “Workflow l.ﬁ.rchiving] .-“-‘-.-:til:uns] Scripting] F'rcuperties]

i iarks Flion
Drefault digtribution list

Workflow  |rvoiceProcessing-1 Ex

#

Fig. 109: The set workflow relationship

After that, you click "OK" to confirm the details dialog of the "Default" file type to
save the changes you made.
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4.4 Release workflow

As of version 2.0, the workflow can be automatically released by enabling the
Release option on the workflow shape prior to the export (Fig. 110).

Al 'ersion [
., Workflow_1-1 - WFMWorkflow

Label [worktiowmame

Name [i/ckiion, Version | pgCommon IKnoten] Ubelgéingel Eigenschalten

General | Descipion |

Languags (' Gesman = Engksh

Shape-Test [Techrcal Hame =l Type WFMWorkflow
[ Wiite shape autocomments
[~ Remave exchusive wite lock Name Workflowname
et o
M e e | TechnicalName Workflow_1

Fig. 110: Releasing a workflow in Visio and in the DOCUMENTS Manager

4.5 Download workflow

As of version 2.0, a copy of the Visio drawing is automatically copied to the server,
and saved under the technical name of the workflow. In doing so, the copy is
overwritten for each new export.

If you want to revert to this drawing at a later time, the workflow shape's
download button can be used to read a list of workflows existing on the server
and, after selection, save a drawing (Fig. 111).

x

L |‘-\l'-:||kﬂ-:rmm
...
ame ersion

N WisicrSheet

General | Descriglion |

| OrdeProcessing 2 QedeiProsesrg .

‘WA ppbe ationF oilLase-2
Lenguage (~ Geman [\FSchlemicate 2

Shape-Ted Im Wordkdiow_1-1 ‘Workfiow_1
I~ 'white tha

™ Riemosve
™ Release

Fils Ty [1E mpdovee

fengst

Ex

Fig. 111: Downloading the Visio drawing of a workflow
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The download can also be executed via the DOCUMENTS Manager by opening
the folder icon in the Visio model field in the workflow details dialog, and then
saving the data file.

‘ DOCUMENTS Manager -- User: Admir

Application  Serversettings  Administration Documents Help
TNew (2 Edt & Update K Delete gy Print “ Configurs
WFMWorkflow

-/ Administration

b @ User Management WEMW.
orkflow (Workflow_1-1)
453 Dacuments

(&0 Public Folders (4 Ent{ = Workflow_1-1 - WFMWorkflow |
1 [ Filetypes (6 Entries) — =
@ Archive servers (2 End | PaCommen | knaten | Uberginge | Eigenschaften | paDesarition | Zugiferchie |
157 Views (3 Entries)

b .£3 Archives and schemd Released
(5 View folders (0 Entri Type WRMWorkilow
I3 Distribution Lists (0 £
a5 Workflows (5 Entries
.5, WFApplicationFol Wersion 1
L5l WFSickCertificate
5. InvoiceProcessin
5., OrderProcessing- Process filetype | [e=F

Mare Workflowname

TechnicalMame Wworkflow_1

i
15 Workflow_1-1 S— %
£, Filing plans (0 Entries )
Number ranges (1 En Visio sheet [Workflow_1 x

#/ Outbar (0 Entries) Wisio image | % Save As | — B
Scripting (24 Entries)

[ Processes (22 Entries] Vi HTMLL (T ) [0 < Locel Disk (C) » SOFTWARE »_ documentst » maneger - &,l Search manager »

(] Scratch Copy (0 Entri
£3 Scratch Copy (Archiv | [L_0K__] [ 4ol FErms -
[ Deleted Processes (0
& Log ook § iy — Save as type: [Allfiles (1) -]

(* Browse Folders

Fig. 112: Downloading the Vision drawing of a workflow via the DOCUMENTS
Manager

4.6 Workflow HTML and image

In the DOCUMENTS Manager, a screenshot of the Visio drawing as well as parts
of an HTML representation of the workflow are saved in the Visio Image and Visio
HTMIL fields. These are automatically created during export; they should be used
in a later version to illustrate the workflow step in DOCUMENTS 4.
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